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Section 1.2  Warranty

Warranty Statement 
  
The warranty period for this equipment is as defined in the quotation upon 
which the order for the equipment was placed. The validity of the warranty 
is conditional upon the product being used strictly in accordance with the 
information provided in this User Manual. 
 
No liability is accepted for loss or damage, or consequential loss or damage 
arising from incorrect use of the equipment. The liability of the Company 
within the guarantee period is limited to repair or replacement of the unit 
and, at the sole discretion of the Company, to the refund of the purchase 
price. 
 
The HybStation is a complex piece of laboratory equipment. Although the 
equipment and software have been designed for ease of use, it is important 
to read the User Manual carefully. If in doubt about any procedures, contact 
Genomic Solutions.  
Only trained personnel should operate the equipment.  
 



  Version 4.0  Issued February 2003 

Record of Revisions 
 

 
Version  

 
Date of issue 

 
Amendments made 

4.0 February 2003 Issued to Software Version 3.61 

   

   

   

   

 
 

Copyright © 2001 Genomic Solutions Inc. All rights reserved.
 
The information contained in this User Manual is the exclusive property of Genomic 
Solutions, except as otherwise indicated, and shall not be reproduced in whole or in 
part without explicit written consent from Genomic Solutions. 
The distribution of this manual may only occur as authorised in writing by Genomic 
Solutions. 

GeneTACR is a registered trademark of Genomic Solutions. 
Microsoft is a registered trademark and Windows is a trademark of Microsoft 
Corporation. 
 

Section 1.3  Record of Revisions



 

 

 
 
 
 
 
 
 
Safe Working Practices 
 
 
Before operating the HybStation or any associated equipment, this User 
Manual must be read carefully, particularly observing all the safety 
warnings and precautions as stated. 
 
During normal use, the HybStation will not present an electrical hazard to 
the operator, but situations could arise where hazardous conditions 
may be present. 
 
The equipment is intended for use by qualified personnel who recognize 
electrical shock hazards and are familiar with the safety precautions 
required to avoid possible injury. 
 
To maintain a safe working environment and protect user personnel 
at all times, the following safe working practices must be adhered to 
when using the equipment: 
 
� Maintain a well-ventilated laboratory. 

� Always keep the work area dry. Always work with dry hands and 
ensure that the work area is kept dry during use. 

� Maintain proper clearance on underside and sides of the 
instrument for proper air conduction. 

 

 

 

 

 

 

 
� Ensure that the power outlet is properly grounded (earthed). Each 

time the equipment is used, the integrity of the main power cable must 
be inspected. 

� Be aware that high voltages are an electrical shock hazard. For 
optimum safety, do not touch the power cable while power is applied. 
Always switch OFF the power at the mains supply socket before 
connecting or disconnecting any cables or equipment. 

� Replacements for blown fuses must be of the same type and 
rating as the original. Using an incorrect fuse could result in a fire 
hazard. 

 
It is also essential that the HybStation be stored and operated within in a 
properly maintained laboratory environment to achieve optimum long-term 
performance.  
The environment must be dust and vibration free and be controlled to 
achieve: 
 

•  Temperature between 5oC and 40oC 
•  Maximum relative humidity of 80% for temperatures up to 31oC, 

decreasing linearly to 50% relative humidity at 40oC. 
•  Pollution degree 2 environment in accordance with IEC 664. 

 

Section   1.4   Safe Working Practices 
and Power Connection



  Version 4.0  Issued February 2003 

 
 
 
 
 
 
 

 
 
 
 

 

Section   1.4   Safe Working Practices 
and Power Connection

Power Connection 
 
The equipment is supplied with a separate main power lead having an 
integral ground (earth) wire. The main power lead must firstly be 
inserted into the power socket at the side of the workstation, as shown 
above. The main outlet plug is then inserted into a properly grounded 
power supply socket.  
 
If any doubt exists about the power supply socket intended for use, a 
qualified electrician must be contacted for advice.  
It must be noted that the workstation is equipped with a universal power 
supply. However, the controlling PC is not equipped with a universal 
power supply, so the PC voltage is factory set prior to dispatch from 
Genomic Solutions. The PC supply voltage setting must therefore not 
be adjusted, except by Genomic Solutions personnel. 
 
Warning: Failure to provide a properly grounded power socket for the 
equipment could lead to an electrical shock hazard. 
 
It is also important to ensure that main supply voltage fluctuations do 
not exceed +/- 10% of the supply voltage. 

 

Main Power Lead 



 

 

 



  Version 4.0  Issued February 2003 

Section 2 
The GeneTAC 

HybStation 

 



 

 

 

Section  2.1  Introduction to the HybStation
The HybStation System 

 



  Version 4.0  Issued February 2003 

 
 

Introduction 
 

The GeneTAC HybStation is an automated system for hybridizing and 
washing microarrays. Protocols can be run simultaneously to achieve 
uniform reproducible results with minimal handling of solutions and slides.  

Each microarray has a port for independent addition of labeled sample. 
The closed environment minimizes evaporation. 

 

System Overview 
The HybStation has six Peltier temperature-controlled devices with fluidics 
capabilities.  

For each module, two microscope slides are placed (array element side 
facing upwards) on the thermally controlled Peltier unit. A polysulphone 
slide cover with chemically inert neoprene O-rings and a stainless steel 
shim is placed over the slides to create the hybridization chamber. Fluids 
enter the hybridization chamber through channels in the slide cover and 
are controlled by valves mounted inside an acrylic manifold. A vacuum 
source moves fluids through the system to the waste bottles.  

Temperature control and fluidics can be varied on the HybStation to 
control hybridization of microarrays. 

Temperature control has a range between 1 and 99° C (± 0.5° C) with 
temperature ramping of 1° C per second.  

 

 

 

 

By separating the slide from the slide cover with a shim of a specific 
thickness, it is possible to maintain a consistent hybridization volume over 
time, regardless of the changing properties of the O-ring. 

 

System Flowpath 
The flow path of the acrylic manifolds, valves, and tubing lines is shown on 
the page above: 

On the diagram the reagent lines are numbered #1, #2, #3, #4, and #5.  

The four lines at the back of the manifold are #6 which is open to air, #7 
for waste bottle #1, #8 for waste bottle #2, and #9 which is a vent line open 
to air.  

There are three valves for each slide: 

� Inlet valve 

� Agitation valve: located between the inlet valve and the slide 
chamber 

� Outlet valve 

Section  2.1  Introduction to the HybStation



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

Section  2.2  Using Slides

(0,0) Datum Corner 
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(0,0) Datum Corner
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Introduction to Using Slides 
The GeneTAC HybStation processes up to 12 slides on six temperature-
controlled modules by washing fluids over the active surface of each slide. 
It is important to always place and seat slides properly on the instrument. 

Slide Sizes 
Two types of slide array assembly can be used with the HybStation; an 
18mm type slide assembly and a 21mm assembly. The 18mm type slide 
assembly has a hybridization area of 18mm x 56mm, whereas the 21mm 
assembly provides a larger hybridization area of 21mm x 68mm, as shown 
in the figure above. 

It must be noted that the two assemblies are quite different and their 
components are therefore not interchangeable.  

An upgrading kit is now available to enable use of the 21mm assembly on 
any HybStation. 
 
Frosted Slides 
The frosted side of a slide must always be placed face-down on the 
carrier.  
It is essential that hybridization is always carried out on the 
unfrosted side of a slide. 
 

 

 

 

 

 

The Slide Sealing System 
To retain the fluids during use, a polysulphone cover is fitted over the 
active surface of the slide. A gasket (neoprene O-ring) is integrated in the 
cover to seal the slide. It is critical that the gasket does not overlap the 
spots on the slide. 
 
Critical Handling Notes 
When handling slides, follow these recommendations: 

� Do not touch or label the active surface of the slide. Fingerprints, 
labels, and pen marks may leach contaminants or prevent sealing 
by the O-rings. 

� Apply labels to the inactive face of the slide at the end nearest the 
home position corner. Maximum rear face irregularity is +/- 50µm, 
that is, maximum label thickness is 100µm. 

� Process slides in pairs. If it is required to process an odd number 
of slides, use a dummy (blank) slide in the unused position. This 
should be of the same slide type as the one being hybridized. 

� Take care to never mark or score the glass slides in any way. 
 

Section  2.2  Using Slides



 

 

 
Using the 18mm Slide Assembly 

 

A slide carrier is placed under each pair of slides to set the position. The 
home position is (0,0). 
 
Placing Slides 

To place slides on the GeneTAC HybStation: 
1. Unscrew the black knob that holds the slide cover in position. This 

releases the cover from the thermal module assembly. 

 

 

 

 

 

 

 

 

 

 
2. To remove the slide cover, gently pull it forward and up. 

The top of the slide cover contains four small red connecting O-rings 
that seal against the reagent manifold. There is an indented area at 
the top center that encloses a small metal guide post that allows the 
cover to be repositioned. 

 

 

 

 

3. Check the O-rings to make sure they are positioned correctly 
within the slide cover. 

4. Place the slides one at a time onto the metal slide holder. The 
metal slide holder is flanged at the top, bottom, and sides to hold 
each slide in position. For correct placement, ensure that the slide 
is positioned tightly against the top right-hand edge of the flanged 
carrier plate with the array elements facing upwards. 

 

 

 

 

 

 

 

 

 
 

5. Place the slide cover into position over the slides and the flanged 
carrier plate. Ensure that the indentation in the top of the block is 
resting against the flanged edge at the top of the metal slide 
holder.

Black Securing Knob 
 

Section  2.2.1  Using the 18mm Slide Assembly
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6. Gently place the slide carrier/cover assembly onto the module, 

positioning the block assembly against the metal guide pin.  

 

 

 

 

 

 

 

 

 
7. Lower the clamp mechanism into position over the slide cover. To 

ensure a good seal, make sure that the slides do not move when 
positioning the clamp on top of the block.  

 

Note: If the system is sealed properly, the four red O-rings appear as fat 
round circles when viewed through the back of the manifold. 

8. Re-attach the locking mechanism by turning the black knob screw 
assembly until fingertip tight. 

Note: Do not over-tighten the knob 

9. Continue placing slides on each module as necessary, following 
steps 1 through 8 until all slides are positioned for the run.  

Section  2.2.1  Using the 18mm Slide Assembly



 

 

 
 
Using the 21mm Slide Assembly 
 

The 21mm slide assembly provides a larger hybridization  area than the 
18mm assembly.  

Note: The 21mm assembly is clamped onto the HybStation in a similar 
way to the 18mm slides, so those details are not repeated again in this 
section. 

When in use, the complete slide assembly is located onto the (yellow 
colored) heat exchanger thermal pads positioned on the HybStation heat 
exchangers. It must be noted that these Thermal Pads should always be 
left in position on the heat exchangers and must not be removed. 

To use the 21mm assembly, proceed as follows: 

 

 
 
 

 

 

Note: When setting up and using the 21mm slide assembly, always 
ensure that the U-shaped slot is located at the top of the Array Slide Base  
 
 
 
 
 
 
 
 
 
 

To use the assembly, proceed as follows: 

 
 
 

Heat Exchanger 
Thermal Pads 

U-shaped slot at the 
top 

Array Slide
Base 

Section  2.2.2  Using the 21mm Slide Assembly
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1.    Place two Slide Pads into the recesses of the Slide Base. 
 
When positioning the pads, care must be taken to ensure that they a
pushed towards the top left-hand corner of the recesses and that the
springs are properly positioned flush with the base. 
These pads will later be used to compress the springs to allow insert
of the Array Slides. 
 
 

Position the Slide 
Pads adjacent to the 
top left-hand corner

Slide 
Pads 
re 
 

ion 

2.    With the slide pads correctly positioned, place the insertion 
tool into the recesses on the left-hand side of one of the slide 
pads.  

This tool will then be used to push the slide pads towards the 
bottom right-hand corner of the base, against the action of the 
springs. 
Section  2.2.2  Using the 21mm Slide Assembly



 

 

3.    Holding the Insertion Tool in position sl
the bottom of the Array Slide Base until it cl
position.  

As the tool slides along, the Slide Pad comp
until the pad clicks into position. When the t
this position, the Slide Pad will remain fixed
withdrawn. 

Note: It is important to ensure that the sprin
seated and that each of the Slide Pads are 

4.    With the springs compressed, the two Array Slides can be 
dropped into the recesses of the Array Slide Base. 

Ensure that the slides are properly seated and that the white / 
frosted area of each slide is positioned at the bottom of the base, 
facing downwards. It is also important to ensure once again that 
the springs are properly seated flush against the base and the 
edges of the Slide Pads. 

Section  2.2.2  Using the 21mm Slide Assembly
ide the tool towards 
icks into the insertion 

resses the springs 
ool has clicked into 
 and the tool can be 

gs remain properly 
secure. 
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5.    To properly position the slides, they 
need to be pushed towards the top left-
hand corner of the Array Slide Base.  

This corner acts as the system datum and 
the slides must always register with this 
datum corner when in use. 

To move the slides into position, place the 
insertion tool into position as shown, then 
slide the tool towards the top of the 
assembly. This will move the Slide Pad and 
allow the springs to push the slides into the 
top left-hand datum corner. 
When the slides are in position, check that 
they are properly seated against the datum 
corner and that the springs are properly 
positioned, flush with the base and against 
the edges of the slides. 

Push the Insertion Tool towards the top of 
the assembly, allowing the springs to 
position the slides at the datum corner 

Gap between
bottom of Slide and
bottom of Slide Pad

6.   Using the Insertion To
downwards to bring the bo
bottom of the Array Slide. 

Note: It is important that t
no gap exists between the
damage occurring to the A

Section  2.2.2  Using th
 
 

ol, carefully slide the Slide Pad 
ttom of the Slide Pad level with the 
 

he edges of these are aligned and that 
m. Failure to do this could result in 
rray Slides. 

This gap 
must be 
closed 

e 21mm Slide Assembly



 

 

7.    Place a metal shim onto the top of the assembly, as shown. 

8.    Prepare the Array Slide Cover for use. To do this, ensure that 
four red colored connecting ‘O’ Rings are correctly positioned into the 
recesses at the end of the cover, and insert two black Array Slide 
Seals into the rectangular recesses in the cover. 

Array Slide Seals 

‘O’ Rings 

9.    After finally checking that the 
positioned, place the Array Slide C
the ‘O’ Ring seals at the top). 
The assembly is now ready for us
Array Slides are correctly 
over onto the assembly (with 

e. 
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Removal of the Array Slides. 
 
To remove the Array Slides from the assembly, first remove the Slide 
Cover. The Array Slide Base can then be positioned onto the 
Extraction Tool.  

The pins protruding from this tool will release the Array Slides and 
Slide Pads when the base is pushed down onto it. 

Remove the Array Slide Base from the Extraction Tool when the 
Array Slides and Slide Pads have been removed. 

Note: It must be no
Array Slides may s
This will depend up
normal. The slides 
damage occurring. 
 Cover, the 

is quite 
s without any 

.2  Using the 21mm Slide Assembly
ted that when removing the Array Slide
tick to the Array Slide Seals.  
on the type of protocol being used and 
can carefully be removed from the seal
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Using Reagents 
 

The GeneTAC HybStation has positions for five reagent or reservoir 
bottles and two waste bottles.  

Note: Before starting any hybridization protocol it is important to 
empty the waste bottles and dispose of the contents properly. 

 
Genomic Solutions Reagents 
 

Genomic Solutions offers hybridization and wash buffer solutions for the 
GeneTAC HybStation. The GeneTAC Hybridization Kit for 12 to 15 
hybridizations includes: 

2 tubes of 2X HybBuffer Hybridization Solution (1ml each) 

1 bottle GeneTAC Medium Stringency Wash Buffer (500ml) 

1 bottle GeneTAC High Stringency Wash Buffer (500ml) 

1 bottle GeneTAC PostWash Buffer (500ml) 

1 package of neoprene O-rings 

2 labeled sample port plugs 

Your Genomic Solutions representative should be contacted for catalog 
numbers and pricing information. 

 
 
 
 
Reagent Guidelines 
 

Reagents provided by Genomic Solutions can be safely used with the 
GeneTAC HybStation. Use the wash solutions in order of increasing 
stringency. 

Never use these solutions in the GeneTAC HybStation: 

•  All acids 
•  All bases 
•  Organic solvents, such as phenol, acetone, chloroform, xylene 
•  Chaotropic solutions, such as guanidine-HCl 
•  Ethanol 

 

If a precipitate occurs, remove the damaged part and soak it in warm, 
ultrapure water overnight. If available, use a continuous flow waterbath, 
which will aid in dislodging the precipitate. Gentle abrasion with a soft 
brush may help to dislodge the precipitate from the slide cover, but take 
care not to scratch the part. 

The manifolds are not removable. 

The hybridization and wash solutions contain sodium dodecyl sulfate 
(SDS). This strong ionic detergent will precipitate out of solution when 
slightly chilled. Inspect solutions before use to assure that precipitation has 
not occurred. SDS will go back into solution upon warming.  

Never use a solution that has a visible precipitate. Also, medium to high 
stringency buffers are always recommended for use. 

 

Section  2.3  Using Reagents
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Basic Maintenance 
 
Cleaning the Case 
Clean the exterior case of the GeneTAC HybStation with a mild detergent 
and rinse with distilled water.  

Caution: Risk of electrical shock can exist. Turn OFF power to the 
GeneTAC HybStation and disconnect the power cord before cleaning the 
instrument. DO NOT allow liquid to enter the inside of the power unit. 
Liquid may damage the power unit and present a potential shock hazard. 

 

Cleaning the Lines 
After completing a hybridization, run a machine clean cycle wash using 
blank slides and ultrapure water. This step is particularly important if the 
machine will be idle for a few days.  

Note: Refer to Section 4.5,  Cleaning the Valves and Lines.

 

 
 

 
Maintaining the O-rings 
Note: It is recommended that the neoprene O-rings be after each run as 
worn O-rings will not seal properly and leaking could occur. If the O-rings 
are re-used, ensure that they are cleaned well before the next run is 
carried out 

To clean the O-rings: 

•  Remove the O-rings from the slide cover. Rinse the cover under a 
stream of water and gently lift an edge of the O-ring, or use 
canned air to remove the O-ring. 

•  Place the O-rings into a boiling bath of ultrapure water at 
approximately 80oC for 1 to 2 minutes.  

•  Remove the O-rings from the bath and allow them to air dry.  

 

To replace the O-rings: 

•  Make sure the channel is free from particulate matter. 

•  Place the O-ring over the channel. 

•  Gently press the O-ring into the groove in the slide lid. 

•  Do not twist the O-ring when replacing it or the slide cover may not 
seal completely. 
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  Version 4.0  Issued February 2003 

Section 3 
Using the 

HybStation 

 



 

 

The ON / OFF Switch 

The Main HybStation Screen 
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Initiating the GeneTAC HybStation 

 
Station, first ensure that there is no disc in 

 ON / OFF switch into the ON position.  

back of the instrument. 

d the main control screen will open. 

Section  3.1  Initiating the HybStation

 

To initiate the GeneTAC Hyb
the disc drive then place the

This switch is located at the 

The system will then start an
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Running a Protocol 
 
Starting a Run 

To run a protocol, proceed as follows: 

1. At the Main control screen, select Start a run.  
The Select The Drive to Load From screen will then appear, 
prompting for the location of the protocol to be defined. 

2. Select the location of the protocol (Floppy Disk or Internal 
Storage). The Choose a Protocol to Load screen will then open, 
listing all available protocols.  

3. Select the protocol to be run. A marker will appear next to the 
protocol selected. 

4. Select Load. The Select Slides for the Run screen will then 
open. At this screen select the slides for use during the protocol. 
The selected slides will then become highlighted.  

Note: To deselect a slide, press the slide number again. To select 
all slides, press Select All at the bottom of the screen.  
The arrows indicate the slide positions selected. The system will 
select positions to ensure even use of all modules. 

5. Select Start. A message screen will then open stating Press 
Continue when you are ready to start this run. 

6. Place the slides into the slide holders.  

Note: For details of how to place slides onto the HybStation, refer 
to Section 2.2 

 

 

.  
 

 

 

 

 
When the slides have been correctly positioned press Continue. The 
HybStation Status screen will then open. 

 

 

 

 

 

 

 

 

 

 

The use of this screen for monitoring purposes is described in Section 3.4, 
Monitoring a Run. 

 

To exit this screen and return to the Main screen, select Close Screen . 

Section  3.2  Running a Protocol



 

 

 

Adding a Probe (Labeled Sample) 
The HybStation software indicates when to add a labeled sample by 
displaying the prompt screen. 

To add a labeled sample: 

1. At the screen, press the Probe button to add a labeled sample for 
the slide. A check mark will then appear next to the Probe button.  

Note: A click will be heard as the valve opens to allow the system 
to vent. This valve must be opened to enable the labeled sample 
to enter the slide chamber. 

  In this example, the probe for slide number 1 is selected. 

 

 

 

 

 

 

 

 

 

2. Inject the labeled sample by pipetting it slowly into the port using a 
standard 200ml pipette. If using the 18mm slide assembly it is 
recommended that 100µl to 110µl is used. This should be 
increased to approximately 140-150µl when using the 21mm slide 
assembly. 

 

 

The probe port is located above a diffusion channel machined into the 
slide cover. There is also a complimentary diffusion channel at the top of 
the slide cavity. Capillary action tends to draw the labeled sample out of 
the first diffusion channel during insertion.  

 

 

 

 

 

 

 

The labeled sample must fill up to the top diffusion channel. This area 
accommodates thermal expansion and contraction of the fluid and fluid 
displacement due to minor thermal expansion of the slide cover. 

3. When the labeled sample has been added, insert the labeled 
sample plug. 

4. Press the Finished button related to the slide where the labeled 
sample was added. The check mark on the screen will then 
disappear. 

5. To add labeled sample to the second slide position, repeat steps 1 
to 4. 

6. When labeled sample has been added to the last slide, press 
Finished at the bottom of the screen. The system will then 

Section  3.3  Adding a Probe
continue with the defined protocol.
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Monitoring a Run 
A hybridization run is monitored at the HybStation Status screen. This 
screen identifies the modules and shows the current status: 

� Module number 
� Temperature 
� Current step 
� Total steps in the protocol 

 
To monitor a run: 

On the Main screen, press System Status . The HybStation Status 
screen will then open. 

 

 

 

 

 

 

 

 
 
In this example, the HybStation Status screen shows the following: 

� A protocol is running on Modules One and Four. 
� The protocol has eight steps, and the first step is in progress. 
� Modules Two, Three, Five, and Six are idle. 
� The Progress area shows a progress bar for each active module. 

Modules One through Six correspond to six progress bars from top 
to bottom. 

 

To view details of a specific module, press the box representing the 
module. A screen will then open showing detailed information.  

 

 

 

 

 

 

 

 

 

This example shows the following information: 

� The name of the protocol on this module is DEMO.HYB. 
� This is Module One. 
� The second step of an eight-step protocol is currently running. 
� The current step is to cycle at 55° C for 12 hours. 
� The module is at the set temperature for the current step. 
� The current temperature is 55° C, the number in parentheses 

indicates the array element temperature. 
� Time Remaining refers to the time remaining for the current step. 
� Total Remaining refers to the time remaining for the current 

protocol. 
 

To return to the HybStation Status screen, press OK . 

To return to the Main screen, press Close Screen on the HybStation 
Status screen. 
Section  3.4  Monitoring a Run



 

 

 
 
 
Aborting a Run 
 

If necessary, a run can be aborted on all modules or on selected modules.  
To abort the run on all modules: 

1. On the Main screen, press System Status . The HybStation 
Status screen appears. 

2. Press Abort . A Confirmation screen will then appear. Press Yes . 
The Main screen appears. 

 

To abort the run on selected modules: 

1. On the Main screen, press System Status . The HybStation 
Status screen appears. 

2. Select the module on which the run is to be aborted. The Status 
screen for the module will appear. 

3. At the upper right-hand area of the screen, press Abort .  
 A Confirmation screen will then appear. 

4. Press Yes. The HybStation Status screen will then appear. 

To abort the run on more modules, repeat steps 2 and 3 above.  

 

To return to the Main screen, press Close Screen. 
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Creating a Protocol 
 

A new protocol can be created using an external PC and then be run 
directly (or saved on a floppy disk), or can be created on the HybStation 
embedded PC for repeated use. 

The procedure in this section describes in general how to create a 
protocol. 

To create a new protocol: 

1. On the Main screen, press Edit or create a protocol . A new 
screen will then appear. 

2. Press Create a new protocol . The Protocol Definition screen 
will then appear. 

3. To begin adding steps, press Add. The Steps screen will then 
appear. 

When a step has been added, the system will return to the 
Protocol Definition screen. 

4. Continue adding as many steps as necessary for the protocol. 

5. Review the protocol steps; use the Up and Down arrows to scroll 
through the steps. 

Note: To remove one of the steps, select the step and press the 
Remove button. 

6. To finish the protocol, press the Finish button.  

Note: The top right-hand area of the screen will indicate that a 
protocol has been defined. 

 7. Press Save Protocol. The Keypad screen will then appear. 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

Section  3.6  Creating a Protocol



 

 

 

 

 

 

 

  

 

 

 

 

Section  3.6  Creating a Protocol
 

 
 

 

 

 

 

 

 

 

 

 

 

 



  Version 4.0  Issued February 2003 

8. At the Please Enter a File Name for the Protocol screen, enter a 
name for the protocol using up to eight alphanumeric characters. To do 
this use the alphanumeric buttons, noting the following: 

� To delete a character, press Bkspc. 

� To cancel the operation and return to the Protocol screen, 
press Cancel. 

To accept name the entry and continue, press OK. The Main screen will 
then appear. 
 
 
If  Finish on the Protocol Definition screen is pressed before the new 
protocol is saved, a warning screen will appear stating: 

You have not saved this protocol. Are you sure you want to lose 
the changes you have made? 
 
To save the protocol, press No .The Protocol screen then appears. 
Press Save Protocol and proceed as described above. 

Section  3.6  Creating a Protocol
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Editing an Existing Protocol 
 

An existing protocol can be edited and saved under the same or a new name 
for repeated use. Editing a protocol effectively means adding or removing steps.

Note: It is only possible to edit a protocol that was created with HybStation 
software. This is done using the touch screen. 

 

Selecting a Protocol for Editing 
A protocol must be loaded before it can be edited. 

To select a protocol for editing, proceed as follows: 

1. On the Main screen, press Edit or Create a Protocol . The Protocol 
screen will then appear. 

2. On the Protocol screen, press Load or Delete Stored Protocol . A 
screen appears, prompting  Where is the Protocol Stored? 

3. Select Floppy Disk or Internal Storage . A list with available protocols 
will appear. 

4. From the list, select the protocol to be edited. A marker to the right-hand 
of the protocol name indicates the selection. 

5. Press Load. The Protocol screen appears, indicating at the top 
right-hand area that a protocol is defined. 

On the Protocol screen, press Edit or review protocol. The Protocol 
Definition screen appears, listing the steps in the protocol. This can then be 
edited as described on the following pages. 

Section  3.7  Editing an Existing Protocol



 

 

 

A Typical Protocol Def

Section  3.8  Adding Steps to a Protocol
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Adding Steps to a Protocol 
 

1. Select a protocol for editing as described on the previous page. 

2. Add a new step either before a specified step or at the end of a 
protocol: 

� To add a step before a specified step, select the step on the 
Protocol Definition screen. A marker will appear to the 
right of the step. Then, press Add at the bottom of the 
screen.  

� To add a step to the end of the protocol, press Add at the 
bottom of the screen without selecting a step. 

To return to the Protocol screen without adding steps, press 
Finish. 

3. Press the step to be added.  

 Note: For a description of all available steps, refer to Section 3.11 

4. Repeat steps 2 and 3 to add more steps to your protocol. 

5. When all required steps have been added, press Finish . The 
Protocol screen will then appear. 

6. On the Protocol screen, press Save protocol . The Keypad 
screen will then appear. 

 

 

 

 

 

 

 

 
 
 

7. Enter a name for the protocol of up to eight alphanumeric 
characters using the alphanumeric buttons, noting the following: 

� To delete a character, press Bkspc . 

� To cancel the operation and return to the Protocol screen, 
press Cancel . 

� To accept your entry and continue, press OK . The Main 
screen will then appear.  

 

If  Finish on the Protocol Definition screen is pressed before the 
new protocol is saved, a warning screen will appear stating: 

You have not saved this protocol. Are you sure you want to 
lose the changes you have made? 

 
To save the protocol, press No .The Protocol screen then 
appears. Press Save Protocol and proceed as described above. 

 

Section  3.8  Adding Steps to a Protocol



 

 

 

Removing Steps from a Protocol 
To remove steps from a protocol: 

1. Select a protocol for editing as described on the previous pages. 

2. Select the step to be removed. A marker to the right of the step 
indicates the se

 

 

 

 

 

 

 

 

 

3. Press Remove
the protocol. 

4. Remove additio

5. When the requ
Protocol screen
Save Protocol

 

 

 

 

 

 

 

 

. Enter a name for the protocol of up to eight alphanumeric 
characters using the alphanumeric buttons, noting the following: 

� To delete a character, press Bkspc . 

Section  3.9  Removing Steps from a Protocol
lection made. 

. The program immediately removes the step from 

nal steps by repeating the above, as required. 

ired steps have been removed, press Finish . The 
 will then appear. On the Protocol screen, press 
 . The Keypad screen will then appear. 

� To cancel the operation and return to the Protocol screen, 
press Cancel. 

� To accept your entry and continue, press OK. The Main 
screen will then appear.  

�  

If Finish on the Protocol Definition screen is pressed before the 
new protocol is saved, a warning screen will appear stating: 

You have not saved this protocol. Are you sure you want to 
lose the changes you have made? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

To save the protocol, press No .The Protocol screen then 
appears. Press Save Protocol and proceed as described above. 
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Deleting a Protocol 
A protocol can be deleted from either a floppy disk or the internal PC 
storage. 

 

To delete a protocol: 

1. On the Main screen, press Edit or create a protocol . The 
Protocol screen will then appear. 

  

 

 

 

 

 

 

 

2. On the Protocol screen, press Load or delete stored protocol . A 
screen then appears requesting the location of the protocol to be 
deleted. 

 

 

 

 

 

 

 

 

 

 

 

 

3. Press Floppy Disk or Internal storage . A screen then appears, 
listing all available protocols. 

 

 

 

 

 

 

 

 

 

4. Select the protocol to be deleted. A marker to the right of the 
protocol will indicate the selection. 

5. Press Delete . The system then removes the protocol. 

Section  3.10  Deleting a Protocol
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 The Protocol Steps 

When steps are added to a new protocol or to a saved protocol, these 
steps can consist of the following, (and as shown in the above window). 

All steps are initiated using the above screen. 

� Single wash Select a solution to flow through the slide 
chambers. 

� Probe Specify where in the protocol the labeled sample is to be 
added and at what temperature. 

� Temperature Enter the temperature at which the GeneTAC 
HybStation will cycle. 

� Multiple wash Select a solution to flow through the slide 
chambers for up to 10 wash steps. 

� Drain Specify the length of time for which you want air to be 
drawn through the slide, to remove a solution. 

� Start loop Create a series of steps to be repeated multiple 
times. 

� End loop Complete the series of steps. 

Any number of steps can be added to a protocol. When a step has been 
added, the Protocol Definition screen appears, listing the new step.  
 
The protocol steps are described in detail on the following pages. 

Section  3.11  The Protocol Steps
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The Single Wash Step 
This step is used to specify flow and hold times and temperatures for a wash step. 
The reservoir and the waste bottle to be used are also selected together with a 
definition of the number of times (cycles) the wash step is to be performed. 

First, the modules selected for a run go to the temperature specified in the wash 
step. Once all modules arrive at the proper temperature, the manifolds are primed 
with the wash solution. The wash bottle valve and the waste valve are open at this 
time. For twelve slides, the two transfer valves (one for each manifold) are also 
open to allow flow through the manifolds without going through any slides. 

Next, the wash solution flows over each slide in turn for the specified time. The 
maximum flow time allowed is 1 minute. For each wash, the valve for the input 
solution and the selected waste bottle are open for all of the slides. In addition, the 
particular slide's inlet and outlet valves are open for the length of time that is 
specified. 

Then, the countdown for the hold time specified is started. All of the wash valves 
are closed at this stage. 

The priority selected determines how the system continues. The priorities are: 

� Normal The program may interrupt the wash cycle on one module to start 
and perform wash steps on other modules, moving back and forth 
between modules.  

� Must not be interrupted (Critical). The program goes through the 
complete wash step on one module before proceeding to the next one.  

� Urgent This step is similar to the Normal priority in that the program 
interrupts the wash step on one module to perform wash steps on other 
modules. However, when Urgent priority is selected the program next 
starts the wash steps for the module with this priority assigned. 
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The Probe Step 
This step defines where in a protocol the labeled target is to be inserted into each 
slide of one, several, or all selected modules. The temperature at which the labeled 
sample is to be inserted can also be set. This temperature can be between 0 and 
99°C.  

When the modules have reached the specified labeled sample temperature, the 
manifolds are purged of their contents (that is, left-over buffer) by switching on the 
two purge valves, the waste valve for waste bottle one, and the air intake valve. The 
air intake and the waste valves are left open to allow the proper flow across the 
slides. 

When the HybStation is within 0.25° C of the target temperature, the Probe screen 
appears, showing the appropriate slide positions. 

The order in which labeled sample is added to modules is not necessarily 
sequential. It is dependent upon the order in which the modules reach the required 
temperature. It is important to be aware of which modules are ready to accept 
labeled sample. 

When Probe is pressed below the first slide position; a check mark appears next to 
the probe button to show it is selected and the inlet valve for the slide is opened. 
Labeled sample is then added through the port by means of a standard 200µl 
pipette with disposal tips (yellow). 

When this has been done, insert the labeled sample plug and press Finished next 
to the Probe button. The inlet valve for the slide is then closed. This process is then 
repeated for the second slide position, and others. As prompted, add the labeled 
sample to each slide in turn by module.  

When labeled sample had been added to all slides, Finished is pressed at the 
bottom of the screen to move on to the next protocol step. 

Section  3.11  The Protocol Steps



 

 

 
 
 
 
The Temperature Step with Agitation 
 

This option is used to define a temperature at which the unit will cycle and 
to set a time for the unit to remain at that temperature. It is recommended 
to use this option immediately after the probe insert step to allow proper 
hybridization of the sample. The time can be set from 1 second  up to 72 
hours. 

The modules are brought to temperature and time countdown starts when 
a module reaches the specified temperature.  

In this cycle,  the agitation option can also be actioned. When selected, 
this option automatically opens and closes the agitation (or pulse) valves, 
allowing the labeled sample to circulate over the entire slide surface for 
optimal hybridization, thus reducing the possibility of local depletion.  

The agitation works on a one-second open, three-seconds closed cycle for 
the duration of the step. Every 5 hours during this process, the slide's inlet 
valve and air valve are opened for 1 second to release any pressure built 
up in the slide module. 

 
 
 
 
The Multiple Wash Step 
 

A multiple wash step consists of several wash steps that are combined as 
one single step. Up to 10 wash steps can be defined under a multiple 
wash, and a multiple wash step can be added several times in a protocol. 
Only one definition of a multiple wash for a protocol can be made. 

When a multiple wash step is defined, a screen similar to the Protocol 
Definition screen appears. This provides access  to screens enabling the 
following to be set: 

� Reservoir bottle to be used 

� Waste bottle to be used 

� Specific wash time and temperature 

� Specific hold time at that temperature 

� Number of times the wash will be performed.  

Unlike the single wash step, the manifolds are not emptied when the first 
wash is finished before the new buffer flows into them. This results in 
some mixing of fluids. 

No choice of scheduling is available with this step. 

Section  3.11  The Protocol Steps
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The Drain Step 
This option is used to select the amount of time to vent and drain the 
slides. 

The slides are drained one at a time by having their inlet and outlet valves 
opened. When the air inlet valve is opened, it allows airflow over each 
slide to the waste bottle.  

 
 
 
 
 
Start Loop 
This option is used to create and name a loop. A loop comprises a series 
of steps that are defined and run a specified number of times.  

Using loops relieves the creation of a long protocol, as it is only necessary 
to list repetitious steps only once. Once a loop is named, it can be added 
to a protocol in the same way as other steps.  

The Start Loop command sets a flag in the protocol list that indicates the 
beginning of the loop.  

End Loop 
This option is used to end a loop and specify the number of times to run 
the loop. When End Loop is pressed having added the desired number of 
steps, you are prompted to enter the name for the loop. You must enter 
the same name you specified when you started the loop.  

 

The following procedures define how to implement each of the protocol 
steps. 

Section  3.11  The Protocol Steps



 

 

 

 

Adding a Single Wash Step 
 
A wash step has two parts: 

� Flow   Fluid from a reservoir flows over the slide for a set length 
  of time. 

� Hold   The valve closes and the chamber heats to a set 
temperature for a defined length of time. 

When adding a wash step, select the reservoir and waste bottle, set flow 
time and temperature, set hold time and temperature, determine how 
many times the wash cycle will run, and specify the priority of the wash 
step. 

It must be remembered that the HybStation can wash only one slide at a 
time. The total wash time is therefore the number of minutes for one wash 
multiplied by the number of slides. 

Note: To return to the Protocol Definition screen without adding a single 
wash step, press Cancel on any of the screens described in the following 
section. 

 

 

1. On the Protocol Steps screen, press Single Wash. The Define 
the Reservoir for this cycle screen then opens. 

 

 

 

 

 

 

 

 

 

2. Press the number of the reservoir bottle to be used (1-5).  
Note: To change the entry, press a different number. The system 
overrides the current entry with the new one. 

3. Press OK. The Define the Waste Bottle for this cycle screen 
opens. Select the waste bottle that the wash solution is to be sent 
to. 

  

 

 

 

 

 

 

Section  3.12.1  Adding Protocol Steps –
The Single Wash Step
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4. Press the number of the waste bottle to be used (1 or 2).  

Note: To change the entry, press a different number. The system 
overrides the current entry with the new one. 

5. Press OK . A screen appears, asking for the amount of time the 
selected solution is to flow over the slide. 

 

 

 

 

 

 

 

 
6. Enter the flow time in minutes and/or seconds. 

Note: To select minutes, press Minutes then press the desired 
number(s). A small marker will appear next to the Minutes button 
to indicate it is selected. Similarly, to select seconds press 
Seconds, then press the desired number(s).  

To change an entry, press Clear and enter a different number. 

It should also be noted that the details in this note apply to a 
number of the following steps in this section of the manual. 

7. Press OK. A screen will appear prompting for the temperature at 
which the wash is to cycle. 

 

 

 

 

 

 

 

 
 
 
 

8. Select the number for the desired temperature.  

To change the entry, press Clear and enter a different number.  

9. Press OK. A screen appears prompting for the amount of time the 
slide is to remain at that temperature. 

 

 

 

 

 

 

 

 
10. Enter the desired length of time in minutes and/or seconds. 
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11. Press OK. A screen appears, prompting for the number of times 
this wash is to cycle. 

  

 

 

 

 

 

 

 

 

12. Press the number of wash cycles. 

Note: The maximum number of cycles is 10. To change your entry, 
press Clear and enter a different number. 

13. Press OK. The Select the Step Priority screen appears. 

 

 

 
 

 

 

 

 

 

 

 

 

1 he step priority. The preferred selection is Must not be 

T

�

�

�

Section  3.12.1  Adding Protocol Steps –
The Single Wash Step
4. Select t

interrupted .  

he priorities that can be set are as follows: 

 Normal. The program may interrupt the wash cycle on one 
module to start and perform wash steps on other modules, moving 
back and forth between modules. "Normal" can be used for a 
single-protocol run, but if used for a multi-protocol run the wash 
timing may be affected. 

 Must not be interrupted (critical). The program goes through the 
complete wash step on one module before proceeding to the next 
one. This is the preferred choice, as it guarantees that all wash 
steps are performed for the exact length of time specified in the 
protocol. 

 Urgent. The program runs an urgent step as soon as possible and 
does not interrupt the step once it has started. A step with Urgent 
scheduling interrupts any other steps that might currently be 
running but cannot be interrupted itself.  

 

When this has been set, the Protocol Definition screen will 
appears with the new wash step displayed. 
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Adding a Probe (Labeled Sample) Step 
This step is used to specify where in the protocol and at what temperature the 
labeled sample is added.  

Note: To return to the Protocol Definition screen without adding a Probe 
step, press Cancel on the screen. 

To add a probe step: 

1. On the Steps screen, press Probe .  
The Enter the Temperature To Probe At screen then appears. 

2. Enter the desired temperature. 
  2003 

3. Press OK. 

Section  3.12.2  Adding Protocol Steps –
The Probe Step



 

 

 
Adding a Temperature Step 
 

This step is used to enter the temperature for hybridization and the length 
of time the system holds that temperature. The time can be set from 1 
second up to 72 hours.  

The temperature step also has an Agitate option. If selected, the system 
agitates the fluid on the slides during a temperature step.  

 

To add a temperature step (hybridization step): 

1. On the Steps screen, press Temperature. The Enter the 
Temperature to Cycle At screen appears. 

 

 

 

 

 

 

 

 

 
2. Enter the desired temperature. 

 

 

 

3. To add agitation, press the Agitate button at the top right of the 
screen. A marker indicates that agitation is selected. 
 
 The system now automatically opens and closes valves during this 
step, allowing the labeled sample to circulate over the entire slide 
surface for optimal hybridization and to reduce the possibility of 
local depletion. 
 

4. Press OK . A screen appears, prompting for the length of time for 
this step. 

 

 

 

 

 

 

 

 

 
 

5. Enter the desired amount of time in hours, minutes, and/or 
seconds. 

6. Press OK. 

Section  3.12.3  Adding Protocol Steps –
The Temperature Step
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Adding a Multiple Wash Step 
 

A multiple wash step is similar to a single wash step but can contain up to 
10 washes within the one step. 

Only one definition of a multiple wash can be made for a protocol. If a 
multiple wash is defined and this option is selected again, a message 
appears asking if the multiple wash is to be re-defined or if the current 
multiple wash is acceptable. If it is selected to re-define the multiple wash, 
either add steps can be added to your multiple wash or steps can be 
deleted from it. 

A multiple wash consists of multiple steps, which are defined on multiple 
screens. To continue from one screen to the next, press the OK button at 
the bottom of a screen. If this button is pressed before making a required 
entry, a warning message appears prompting an entry before continuing.  

To add a multiple wash: 

1. On the Steps screen, press Multiple Wash . The Multiple Wash 
Definition screen then appears. 

  

 

 

 

 

 

 

 

 

 

 

 
Note: To return to the Multiple Wash Definition screen from any of the 
following screens without adding a wash step, Cancel can be pressed. 
To return to the Protocol Definition screen without adding a multiple wash 
step, press Finish. 

 

2. Press Add. The Reservoir screen appears, prompting you to 
select a reservoir bottle.  

 

 

 

 

 

 

 

 

 

 

3. Press the number of the reservoir bottle to be used (1-5). The 
number appears in the box above the available choices. To 
change the entry, press a different number. The system overrides 
the current entry with the new one. 

Section  3.12.4  Adding Protocol Steps –
The Multiple Wash  Step



 

 

 

 

4. Press OK. The Waste Bottle screen appears, prompting for 
selection of a waste bottle for this cycle. 

 

 

 

 

 

 

 

 

 

5. Press the number of the waste bottle to be used  
(1 or 2). The number appears in the box above the available 
choices. To change the entry press a different number. The 
system overrides the current entry with the new one. 

6. Press OK. A screen appears, prompting for definition of the flow 
time for the wash. 

 

  

 

 

 

 

 

 

 

 

7. Enter the length of time the fluid should flow in minutes and/or 
seconds. 

e: To select minutes, press Minutes then press the desired 

 

 

 

 

 

 

 

 

 

  

Section  3.12.4  Adding Protocol Steps –
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Not

number(s). A small marker will appear next to the Minutes button 
to indicate it is selected. Similarly, to select seconds press 
Seconds , then press the desired number(s).  

To change an entry, press Clear and enter a different number. 

8. Press OK. A screen appears prompting for a temperature step at 
which the wash is to cycle. 

 

9. Press the number(s) for the desired temperature. To change the 
entry, press Clear and enter a different number. 

10. Press OK. A screen appears, prompting for the length of time the 
temperature is to be maintained. 
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11. Enter the desired length of time in minutes and/or seconds. 

Note: To select minutes, press Minutes then press the desired 
number(s). A small marker will appear next to the Minutes button 
to indicate it is selected. Similarly, to select seconds press 
Seconds , then press the desired number(s).  

  To change an entry, press Clear and enter a different number. 

12. Press OK. A screen appears prompting for the number of times 
that the wash is to cycle. 

 

  

 

 

 

 

 

 

 

 

 

 

 

13. Select the desired number of cycles. The maximum number of 
cycles is 10. 

 To change the entry, press Clear and enter a different number.  

14. Press OK. The Wash Definition screen appears with the wash 
step displayed.  

15. Continue adding wash steps as desired, up to 10 steps, by 
repeating the previous procedures. 

16. When all steps have been added to the multiple wash, press 
Finish. The Protocol Definition screen appears, listing the Multiple 
Wash as one step. 
Section  3.12.4  Adding Protocol Steps –
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Adding a Drain Step 
 

The drain step is used to select a specified length of time for which each 
slide is drained. 

Note: A drain step is only used for the removal of prehybridization 
solution. 
To add a drain step: 

1. On the Steps screen, press Drain. The Define Drain Time screen 
appears. 

 

 

 

 

 

 

 

 

 

 
2. Enter the amount of time that the system is to drain, in minutes 

and/or seconds. The maximum time is 20 minutes. 

  

 

 
 

 
Note: To select minutes, press Minutes then press the desired 
number(s). A small marker will appear next to the Minutes button 
to indicate it is selected. Similarly, to select seconds press 
Seconds , then press the desired number(s).  

  To change an entry, press Clear and enter a different number. 

3. Press OK. 

 

Section  3.12.5  Adding Protocol Steps –
The Drain Step
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Adding a Loop 
A loop is a series of steps that are defined and saved to use in a pro
where a number of steps is repeated several times. Rather than add
these steps repeatedly, they can be saved as a loop that forms part 
final protocol. 

To create a loop: 

1. On the Steps screen, press Start Loop . The Keypad scree
appears, prompting for a name to be entered for the loop. 

 

 

 

 

 

 

 

 

 

2. Enter a name of up to eight alphanumeric characters using t
alphanumeric buttons. 

Note: To delete a character, press Bkspc . 
To cancel the operation and return to the Protocol screen, p
Cancel. To accept the entry and continue, press OK .  

 
The Protocol Definition screen will then appear showing a ne
step called Start loop xxx, where xxx is the name defined for
loop. 

3. Press Add. The Steps screen then appears. 

 

 

tocol 
ing all 
of the 

n 

he 
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w 
 the 

4. Add steps until all desired steps are listed on the Protocol 
Definition screen. 

5. On the Steps screen, press End Loop . A Keypad screen then 
appears, prompting for the name of the loop. 

6. Enter the same name for the loop previously entered in  
step 2. The system then checks the name to make sure it 
corresponds with a start loop. 
 
Note: If the correct loop name is not entered, a message appears 
informing that the name is not valid and to please try again.  

7. To return to the Keypad screen, press OK.  

When a valid loop name has been entered a screen appears 
prompting for the number of times the loop is to be executed.  

 

 

 

 

 

 

 

 

 

 
8. Enter a number from 1 to 10. The Protocol Definition screen then 

appears with the loop step listed. 

 

Section  3.12.6  Adding Protocol Steps –
Adding a Loop
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Section 4 
Maintaining the System 

 



 

 

 
 

 
 

 
 
 

 

 

 

 

 

 

 

 

 

 

Accessing the Maintenance Screen 
 
All maintenance options are accessed through the Maintenance 
(Choose an Option) screen. 

To open the Maintenance screen: 

On the Main screen, press Maintenance. The Maintenance screen 
then opens. 

To return to the Main screen, press Finish . 

Section  4.1  Accessing the Maintenance Screen
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Checking a Module Temperature 
 

Module temperatures can be checked using the Module Status 
screen. The screen lists the current temperatures of the six 
modules. 

To view current module temperatures: 

On the Maintenance screen, press Module Status . The Module 
Status screen opens. 

To return to the Maintenance screen, press Close . 

Section  4.2  Checking a Module Temperature



 

 

 

Testing the System Valves 
A number of valves are incorporated into tion systems.  

Each slide has three dedicated valves: 

� Inlet Valve 

� Agitation Valve 

� Outlet Valve 

Additionally, there are bottle and air inlet 
transfer valves, and valves for the manifo
secondary primers.  

The Valve Screen is used to manually op
liquid through them. 

To test selected valves: 

1. Place tubes 1 through 5 into a sin

2. On the Maintenance screen, pres
appears. 

 

 

 

 

 

 

 

 
3. Select the valve/s to be tested.  

 

 

 
Note: It must be ensured that an input valve is not selected for an 

Section  4.3  Testing the System Valves
the HybSta
valves, waste valves, vent and 
lds, called primary and 

en and close valves and run 

gle container of ultrapure water. 

s Valve. The first Valve Screen 

empty or non-existent bottle (reservoir). A check mark appears next to 
each selected valve. 

4. Observe the flow of the liquid. 

To select valves for individual slides, press Next at the bottom of the 
screen. The second Valve Screen will then appear, listing all three 
valves for slides 1 through 4. 

 

 

 

 

 

 

 

 

Select the valve/s to be tested. A check mark appears next to each 
selected valve. 

To return to the first Valve screen, press Previous. To select valves 
for further slides, press Next. 
To close a Valve screen and return to the Maintenance screen, press 
Close . 
To stop testing the valves and return to the Main screen, press Finish 
on the Maintenance screen. 

Note: Always ensure that all valves are turned OFF before closing the 
maintenance screen. 
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Testing the Heating Element of a Module 
The heating element of a module is tested as follows 

 

1. On the Maintenance screen, press Temperature. The View 
Modules screen opens. 

 

 

 

 

 

 

 

 

 

 

2. Select a module on which to test the heating element. A 
Temperature screen then opens for the module. 

 

 
 

 

 

 

 

 

 

 

 

 
 

3. Enter a target temperature that is higher or lower than the current 
temperature using the keypad on the right-hand side of the 
screen. 

4. Press Run. 

5. Observe the temperature increase or decrease. 

6. Press Stop to enter a new target temperature and use the keypad 
to enter the new temperature. 

7. Press Close to stop the test and return to the Maintenance 
screen. 

Bus Reset can be pressed to reset data transmission with the module 
should any communications problem occur. 

Section  4.4  Testing the Heating Element
of a Module



 

 

 
 
Cleaning the Valves and Lines 
 

A machine cleaning cycle should be performed on modules that were used 
after each run. The water in this cycle removes solutions to prevent 
precipitation in the valves and lines. The cleaning program allows the 
selection of slide positions for cleaning.  

 

To clean the valves and lines: 

1. On the Maintenance screen, press Machine Cleaning Cycle . 
The Slide Positions screen will then open. 

 

 

 

 

 

 

 

 

 

2. To select specific slides, press the slides on the screen. To select 
all slides, press Select All . 

 

 

 

 

 

3. To start the cleaning cycle, press Start . A message appears, 
prompting preparation of the HybStation by: 

� Placing tubes 1 through 5 into a single container of 
ultrapure water 

� Fitting slides at all positions selected for cleaning 
 

 

 

 

 

 

 

 

 

 

 

4. Press Continue. The cleaning cycle will then start. 

Note: To maintain a clear fluidic system it is good to do a Machine 
Clean cycle using warm water at approx. 85oC every month. 

 

Section  4.5  Cleaning the Valves and Lines
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Changing the Network Address 
 

If multiple HybStations are being run in a network, each instrument must 
have a unique network address. 

The Network Address screen is used to change the network address of 
the GeneTAC HybStation. 

To change the network address: 

 

 

 

 

 

 

1. On the Maintenance screen, press Network Address . The 
Network Address screen appears: 

 

 

 

 

 
 
 
 
 

2. Use the up arrow and down arrow buttons to change the network 
address displayed to the left. Use "1" for the instrument closest to 
the controlling computer. 

3. Press OK to return to the Maintenance screen. 
Section  4.6  Changing the Network Address



 

 

 

 
 
 

 

 

 

 

 

 

 

 

 

 

Making a Back-up Disk
Make a backup copy of the protocols on a disk using the Make 
Back-up Disk screen. 

To make a backup disk: 

1. Insert an IBM-formatted floppy disk into the disk drive. 

2. On the Maintenance screen, press Make Back-up Disk  

 A message screen opens: 

3

Section  4.7  Making a Back-up Disc
. Press Start 
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Upgrading the Hybstation Software
 

Software for the HybStation must be upgraded when a new version is 
released.  

To upgrade the software: 

1. Insert the floppy disk that contains the software upgrade. 

2. On the Maintenance screen, select Software Upgrade and follow the 
instructions on the screen. 

Note: Be certain to insert the disk before pressing OK on the second screen. 
If the disk is not inserted when OK is pressed, turn off the HybStation and 
repeat the process. 

Section  4.8  Upgrading the Hybstation Software



 

 

 

Section  4.9  Setting the Date and Time
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Setting the Date and Time 
 

The date and time for the HybStation at the Set Date and Time screen. 

 

To set the date and time: 

1. On the Maintenance screen, select Set Date & Time. The Date 
and Time screen opens. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 

2. Press the left and right arrows to edit the year, month, day, hours, 
or minutes when the selection is in the currently editing field. 

3. Press the up and down arrows until the correct numbers appear 
near the top of the screen. 

4. To accept the new settings and return to the Maintenance screen, 
press OK . 
 
To return to the Maintenance screen without accepting the new 
settings, press Cancel . 

Section  4.9  Setting the Date and Time
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Introduction to the PC Methods Editor Software 

The PC Methods Editor software runs on a PC and can be networked to 
the HybStation. Using the software, protocols can be created, edited, and 
printed. 

To connect the HybStation to a PC, a communications lead (Part No. 
H2001016) is used between port PL1 on the HybStation and the PC, as 
shown above. 

To network more than one HybStation together, a communications lead 
(Part No. H2001013) is used between the PL2 ports on the connected 
HybStations. 

 

Installing the PC Methods Editor Software 
The software for the PC Editor is available from Genomic Solutions and is 
installed as follows: 

1. Install the software by copying the self-installing file to the PC and 
executing it. 

2. At the PC navigate to the folder where the program is installed.  

 C:\ProgramFiles\GenomicSolutions\HybStationPC. 

3. Launch the program by double-click the icon. 
 
The Main window will then appear. 

 

 
 
Working in the PC Editor 
The software is easy to use and is controlled from the Main window.  

The main window comprises: 

� The Menu Bar providing access to functions for working with 
protocols via menus.  

� The Toolbar provides access to functions for working with 
protocols via buttons.  

As shown on the above figure, the first four toolbar buttons are 
standard Windows program buttons and the next three buttons are 
used when creating or editing a protocol: 

� The Step List area shows a list of all the steps in the current 
protocol.  

  Note: To select a step, left-click on it.  

� The Step Properties area shows the properties of a selected 
step.  

The Network Status area, used when networking, shows all the Genomic 
Solutions devices connected to the PC including the instrument type and 
its status.  

Section  5.1  Introduction



 

 

 
 
 
 
Opening a Protocol 
 

A protocol is opened through the File menu or by using the toolbar button. 

 

1. To open a protocol, either: 

� From the File menu, choose Open . 

� On the tool bar, click the Open button. 

2. The standard Browse dialog box will then open. 

3. Browse to the location where the protocol is stored. This can be 
the PC hard drive or a floppy disk. 

4. Select a protocol and click Open .  
 The Main window will then open showing the protocol steps. 

At the Main window the step list (on the left) shows all steps in the 
protocol, and the step properties are shown in the view area on 
the right. 

   

 To view the properties of any step, click on the step. 

To view additional step details of step properties, click the Advanced 
tab. 

 

Section  5.2  Opening a Protocol
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Creating a New Protocol 
 

When the PC Methods Editor software first opens, the main scree
blank step list. Steps are then added to create a new protocol.  

 

To create a new protocol, proceed as follows: 

1. Start a new file. To do this either select New from the File 
on the toolbar click the New button.  

The Main software window will then appear, having a blank step li

 

 

 

 

 

 

 

 

 

 

 

 

2. To add a step to the new protocol, select Add Step from t
menu or click on the Add Step button on the toolbar. 

 

n has a 

menu or 

st. 

he Edit 

 

 

The New Method Step dialog box will appear. 

 

 

 

 

 

3. From the Steps drop-down list, select the step to be added.  
 All available steps will appear in the list. 

 

 

 

 

 

 

 
4. Click OK. 

5. Repeat the above procedures to add additional steps to the 
protocol. 

6. From the File menu, choose Save. The Save As dialog box will 
then appear, allowing the new protocol to be saved. 
Note: For additional information refer to the next section, Saving a 
Protocol. 

Section  5.3  Creating a New Protocol



 

 

 
 
 
Saving a Protocol 
Changes to a protocol can be saved under the current protocol name or 
using a new name and create a protocol. When you create a new protocol, 
you can save it to any directory under any name. 

 

To save a protocol under a new name: 

1. From the File menu, choose Save As. The Save As dialog box 
appears. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Browse to the directory where the protocol is to be saved. 

3. In the File name field, enter a name for the protocol. 

Note: Because the HybStation does not permit the use of long file 
names, use a name with 8 characters or fewer. 

4. Click Save or press the Enter key. The software will then save the 
protocol with a .HYB extension. 

 

 To save changes to a protocol, do one of the following: 

� From the File menu, choose Save. 

� On the toolbar, click the Save button. 
If the HybStation is not networked to a PC, a protocol can be saved 
onto a floppy disc and transferred to the HybStation.

Section  5.4  Saving a Protocol
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Editing a Protocol 
A protocol can by edited by adding, inserting, or deleting steps.  

Note: It must be noted that a protocol created using the methods editor 
software on the HybStation cannot be edited using this program. 

 

Adding Steps to a Protocol 
When a step is added to a protocol, PC Methods Editor software places 
the steps at the end of the protocol. 

To add a step to an existing protocol: 

1. Open a protocol. The Main window will then appear, showing the 
steps for the protocol. 

2. Do one of the following: 

•  From the Edit menu, choose Add Step. 

•  On the toolbar, click the Add Step button. 

The New Method Step dialog box will then appear. 

 

 

 

 

 

 

 

 

 

3. From the Steps drop-down list, select the step to be added. All 
available steps are shown in the list. 

 

 

 

 

 

 

 
 

4. Click OK. 

5. Repeat Steps 2 through 4 to add additional steps to the protocol. 

6. Save the changes to the protocol: 

•  To save the changes using the same protocol name, choose 
Save from the File menu. 

•  To save the changes using a different protocol name, choose 
Save As from the File menu.  

Note: Always use a file name with 8 characters or less, or make 
the first 8 characters recognizable. 

 

Section  5.5  Editing a Protocol



 

 

 
 
 
 
Inserting Steps into a Pr
When a step is inserted into a p
selected step in the protocol. 

 

To insert a step into a protocol:

1. Open a protocol. The M
steps for the protocol. 

2. In the step list, click the

3. Do one of the following

•  From the Edit menu

•  On the toolbar, clic

 The New Method Step dia

 

 

Section  5.6  Inserting Steps Into a Protocol
otocol 
rotocol, it will be positioned before a 

 

ain window will then appear, showing the 

 step before the location of the new step. 

: 

, choose Insert Step. 

k the Insert Step button. 

log box will then open. 

 

 

 

 

4. From the Steps drop-down list, select the step to be inserted.  
 All available steps will be shown in the list. 

 

 

 

 

 

 

5. Click OK. 

6. Repeat Steps 2 through 5 to insert additional steps into the 
protocol. 

7. Save the changes to the protocol: 

•  To save the changes using the same protocol name, choose 
Save from the File menu. 

•  To save the changes using a different protocol name, choose 
Save As from the File menu.  

Note: Always use a file name with 8 characters or less, or make 
the first 8 characters recognizable. 
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Deleting Steps from a Protocol 
 

To delete a step from a protocol: 

1. Open the protocol. 

2. The Main window will then appear, showing the steps of the 
protocol. 

3. In the step list, click on the step to be deleted. 

4. Do one of the following: 

� From the Edit menu, choose Delete Step . 

� On the toolbar, click the Delete Step button. 

 A Confirmation dialog box will then appear : 

 

 

 

 

 

 

 

 

 

 

 

 

5. Click Yes. 

6. Save the protocol changes: 

•  To save the changes using the same protocol name, choose 
Save from the File menu. 

•  To save the changes using a different protocol name, choose 
Save As from the File menu.  

Note: Always use a file name with 8 characters or less, or make the 
first 8 characters recognizable. 

Section  5.7  Deleting Steps from a Protocol



 

 

 

File Name Method Title – description of protocol

Section  5.8  Setting a Method Title
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Setting a Method Title 
 

The method title is the name that appears in parenth
protocol window, next to the protocol name. 

The method title is used to add a description of the p
name. 

To set a method title for a protocol: 

1. Open the protocol. 

2. From the File menu, choose Set Method T
dialog box appears. Enter a description of th

 

 

 

 

 

 

3. Type a description of the protocol. 
4. Click OK or press the Enter key. 

 

eses at the top of the 

rotocol to the file  

itle. The Method Title 
e protocol. 

 

 

 

 

To change the method title for a protocol: 

1. Open the protocol. 

2. From the File menu, choose Set Method Title. The Method Title 
dialog box appears. 

3. In the text field, highlight the current entry, then type a new 
description for the protocol. 

4. Click OK or press the Enter key. 

Section  5.8  Setting a Method Title



 

 

 
The Protocol Steps 
Introduction 
Steps can be added to a protocol in the PC Editor by selecting them from 
the New Method Step drop-down list, then setting durations, 
temperatures, and priorities. 
The Steps drop-down list offers the following choices:  

 

 

 

 

 

 

 
� Introduce Probe  Specify the temperature at which the labeled 

sample is added. 

� Set Slide Temperature  Specify the temperature of the slides. 

� Wash Slides  Select the wash solution(s), temperature, and flow 
time. 

� Drain Slides  Specify the amount of time air should be drawn over 
the slide to remove a solution. 

� Start Loop  Create a series of steps that is repeated multiple 
times. 

� End Loop  Select the number of repetitions of the series of steps. 

Additional details about the functions of these steps are provided later 
in this section. 

 

 

 

To display the Steps drop-down list, carry out one of the following: 

� From the Edit menu, choose Insert Step . 

� From the Edit menu, choose Add Step . 

� On the toolbar, click the Insert Step button. 

� On the toolbar, click the Add Step button. 

 
Scheduling 
The timing of protocol steps is controlled by scheduling. This is set when 
each step is defined. 

Each module on the HybStation runs independently. If all the steps are set 
to Normal scheduling, the GeneTAC HybStation performs the steps 
concurrently for each module. For example, if Modules 1 through 4 are 
selected for a protocol that has three steps, the system performs Step 1 on 
all 4 modules, then Step 2, etc. But some resources required by the steps 
use parts of the station exclusively. For example, the high power input 
required by the Peltier unit when heating the slides. As a result of this, only 
one module can use the resource at a time, while the other modules have 
to wait. 

In some cases, the time spent waiting for HybStation resources may not 
affect the experiment being carried out. There are cases, however, where 
a wait after a certain step may affect the experiment results. For example, 
a wash step flushes solution through the slide and holds it for a given time. 
When the hold time begins, the manifold is available for another step to 
use and might not be available to implement a second wash on the 
particular slide. As a result, the wash solution may be held longer than 
anticipated, which may affect the outcome of an experiment. 

Section  5.9.1  The Protocol Steps –
Introduction
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To avoid potential problems of this type, Critical or Urgent scheduling can 
be employed. If this is used, it must be considered how this scheduling will 
affect the other modules, as follows: 

� The HybStation can implement steps with Normal scheduling on all 
modules at the same time, depending on the procedures required by 
the step. This is the most efficient use of the processing time. 

� If Critical or Urgent scheduling is used, the current step ties up the 
HybStation because no other step can run at the same time. This is 
the least efficient use of the processing time but may be necessary for 
the processes involved. 

 

Three scheduling options are available, as follows: 

Normal 
Critical (This step must not be interrupted) 

Urgent (This step will be run as soon as possible) 

 

When a step finishes processing on any of the modules, the HybStation 
looks to see which step or steps it can start next. If a step with Urgent 
scheduling is ready to start, it takes priority, followed by steps with Critical 
scheduling, and lastly by steps with Normal scheduling. 

 

 
 
Normal Scheduling 
Normal is the default scheduling setting. The program may interrupt a step 
on one module to start and perform steps on other modules, moving back 
and forth between modules. When Normal scheduling is selected for a 
wash step, for example, there is no guarantee that the temperature steps 
within the wash step will be performed for the exact length of time 
determined by the protocol.  

Normal scheduling should therefore be applied to steps such as pre-
conditioning the slide, the pre-hybridization wash, the introduction of a 
labeled sample, or the hybridization period. 

Critical Scheduling 
Before performing a step with Critical scheduling, the HybStation checks 
that all resources are available before starting the step so it can go 
through the complete step on one module before proceeding to the next 
one. This is the preferred choice, since it guarantees that all wash steps 
are performed for the exact length of time specified in the protocol. 

Once a step with Critical scheduling has started, it ties up the whole 
station, and no other step can run at the same time.  

If several steps are to run consecutively, specify those steps with Critical 
scheduling. In that case, the HybStation works through all these steps 
without interruption. 

Urgent Scheduling 
The program runs an Urgent step as soon as possible and does not 
interrupt the step once it has started. A step with Urgent scheduling 
interrupts Normal steps that are currently running. An Urgent step cannot 
interrupt a Critical step, but can supersede it. 

Section  5.9.1  The Protocol Steps –
Introduction



 

 

 
 
 
 
The Introduce Probe (Labeled Sample) Step 
 

This step is used to specify where in the protocol and at what temperature 
the labeled sample is added. The temperature can range from 1° to 99° C.  

To introduce a labeled sample: 

1. From the Steps drop-down list, choose Introduce Probe. In the 
Main window, a labeled sample step is added on the left, with the 
corresponding tabs on the right-hand side. 

 

 

 

 

 

 

 

 

 
 
 
 
 
 

2. On the Probe tab: 

� Optionally, enter a brief description for this step in the protocol 
by highlighting the current entry and typing a new one. The 
description will replace the name of the step in the step list.  

� Enter the temperature at which it is required to introduce the 
labeled sample, by highlighting the current entry and typing a 
new one. 

 

Section  5.9.2 The Protocol Steps –
Introduce Probe
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The Set Temperature Step 

This step is used to set the temperature for hybridization and the length of 
time for which the system will cycle at that temperature.  

To set the hybridization temperature: 

1. From the Steps drop-down list, choose Set Slide Temperature. In 
the Main window, a temperature step is added on the left, with the 
corresponding tabs on the right. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 2. On the Temperature tab: 

� Optionally, enter a brief description for this step in your protocol by 
highlighting the current entry and typing a new one. The 
description replaces the name of the step in the step list.  

� Enter the desired temperature by highlighting the current entry and 
typing a new one. 

� Enter the length of time for the temperature step in hours (H), 
minutes (Min), seconds (Sec). 

� Click the Advanced tab. 
 

 

 

 

 

 

 

 
2. On the Advanced tab: 

� To add agitation, make sure Enable Agitation is checked. The 
system will then automatically open and close the agitation 
valves during this step, allowing the labeled sample to circulate 
over the entire slide surface for optimal hybridization and to 
reduce the possibility of local depletion. 

� Select the required scheduling for this step. 

Section  5.9.3  The Protocol Steps –
Set Temperature



 

 

 

The Wash Slides Step 
 

This step is used to select a solution from one of the five availab
reservoirs to flow through the slide chambers for a specified per
at a specified temperature. 

To define a Wash Slides step: 

1. From the Steps drop-down list, choose Wash Slides. In
window, a wash slides step is added on the left, with the
corresponding tabs on the right. 

  

 

 

 

 

 

 

 

 

2. On the Wash Slides tab: 

� Optionally, enter a brief description for this step in th
by highlighting the current entry and typing a new on
description replaces the name of the step in the step

� From the Source drop-down list, select one of the fi
reservoirs. 

� From the Waste drop-down list, select a waste bottl
solution. 

 

 

Section  5.9.4  The Protocol Steps –
Wash Slides
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� Define a temperature by highlighting the current entry and 
typing a new one. 

� Define a flow time and a hold time by highlighting the current 
entries and typing in new ones.  

� Click the Advanced tab. 

 
 

 

 

 

 

 

 

 

 

 

3. On the Advanced tab: 

� Set the number of times you want the wash to cycle by 
highlighting the current entry and typing a new one. 

� Select the scheduling for this step. 
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The Drain Slides Step  
 

This step is used to specify the length of time that each slide is drained.  

To define a drain step: 

1. From the Steps drop-down list, choose Drain Slides. In the Main 
window, a drain slides step is added on the left, with the 
corresponding tabs on the right. 

 

 

 

 

 

 

 

 

 

 
2. On the Drain Slides tab: 

� Optionally, enter a brief description for this step in the protocol 
by highlighting the current entry and typing a new one. The 
description replaces the name of the step in the step list.  

 

 

 

 

� From the Waste drop-down list, choose a waste bottle. 

� Specify the length of time that slides are to drain by 
highlighting the current entry and typing a new one. 

3. Click the Advanced tab. 

 

 

 

 

 

 

 

 

 

 
4. On the Advanced tab, select scheduling for this step. 
Section  5.9.5  The Protocol Steps –
Drain Slides



 

 

 
Creating a Loop 
A loop can be created when a series of steps are repeated in a protocol. A 
loop must have a Start Loop step at the beginning and an End Loop step 
at the end of the series. The number of cycles that the series is repeated 
in defined in the End Loop step. 

A nested loop is created when a series of steps are repeated within 
another loop. Each nested loop must also include a Start Loop step and an 
End Loop step. 

To create a loop: 

1. From the Steps drop-down list, choose Start Loop. In the Main 
window, a start loop step is added on the left, with the Loop tab 
on the right. 

 

 

 

 

 

 

 

 

 

 

2. On the tab: 

� Enter a brief description of this step by highlighting the current 
entry and typing a new one. The description replaces the 
name of the step in the step list.  

 
 

� Enter a name for the loop. 

� Add steps to the loop. 

� From the Steps drop-down list, choose End Loop. In the Main 
window, an end loop step is added on the left, with the End 
Loop tab on the right. 

  

 

 

 

 

 

 

 

 

 

 

3. On the tab: 

� Enter a brief description of the step by highlighting the current 
entry and typing a new one. The description replaces the 
name of the step in the step list.  

� Enter the loop name that was entered on the Start Loop tab. 

� Enter the number of cycles that the loop is required to run for. 

Section  5.9.6  The Protocol Steps –
Creating a Loop
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Printing a Protocol 
An open protocol can be printed out to review the protocol. 

 

To print a protocol: 

1. Ensure that the protocol to be printed is open. 

2. Do one of the following: 

� From the File menu, choose Print. 
� On the toolbar, click the Print button. 

3. On the Print dialog box, click OK. 

Note: To see what a printed protocol would look like choose Print 
Preview . 

4. Click OK. 

 

Section  5.10  Printing a Protocol
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 Step Description

1 Probe Temperature: 65oC 

2 Temperature Temperature: 55oC 
Time: 18 hours 
Agitate: Yes 

3 Single Wash Reservoir: 1 
Waste Bottle: 1 
Flow Time: 10 Seconds 
Temperature: 55oC 
Temperature Time: 20 seconds 
Cycles: 3 

4 Single Wash Reservoir: 2 
Waste Bottle: 1 
Flow Time: 10 Seconds 
Temperature: 25oC 
Temperature Time: 20 seconds 
Cycles: 3 

 

Example of a Typical Protocol
 

This section shows an example of a typical protocol. 

Section  6  Example of a Typical Protocol
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5 Single Wash Reservoir: 3 
Waste Bottle: 1 
Flow Time: 10 seconds 
Temperature: 25oC 
Temperature Time: 20 seconds 
Cycles: 3 

   

   

voirs should contain the 
lutions: 

 Wash Buffer 
sh Buffer 

Section  6  Example of a Typical Protocol
During this typical protocol the reser
following GeneTAC Wash Buffer So
 
Reservoir 1: Medium Stringency
Reservoir 2: High Stringency Wa
Reservoir 3: Post Wash Buffer 
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